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8 Release process

8.1 Fundamentals

In Teamcenter, processes (workflows) are implemented for several release levels. A release of a
revision in Teamcenter means that this revision can no longer be changed and receives a certain
status. In addition, a release date and the releasing person are noted on the revision and a neutral
format generation takes place, where the formats can be selected. Possible formats are JT, PDF, Tiff,
STEP, IGES, DXF and DWG.

A set status cannot be reset. After a revision has been released, a new revision must be created in
order to make changes. Conversely, a new revision can only be created if the previous revision has a
status.

The following release levels are provided:

Engineering Release (ER): This release is used to define a revision in the PLM system. Optionally, a
~self-release” without check (,review”) or a check according to the ,4-eye-principle” is carried out.

When the release is set to ,,ER”, there is no SAP transfer. A new revision can be created without a
change notice (change notice or simply change).

Preseries (pre-series, PS): This release requires a check according to the ,4-eye-principle”. The
auditor can be selected by the initiator of the workflow, but must come from his group (,KV“) and
have the role ,Design Admin“. This is preset by the workflow. When releasing after ,PS“, an SAP
transfer takes place. The SAP system is automatically selected on the basis of the current group of the
releasing person, for example, in the group ,EI” PE1 is transferred to the SAP system.

A distinction is made between ,initial release” and ,,subsequent release”. With the first release, a
revision of a part is set to the status ,PS“ for the first time; this does not have to be revision 00, since
only the status ,,ER“ can be set beforehand. For a follow-up release, a change is mandatory so that
the changes can be tracked.

8.2 Engineering Release (release after "Er")

During release, certain conditions are checked without which the workflow does not start. These are
conditions for a design release:

e This is an object of type ,FFG EngltemRevision®.
¢ All mandatory attributes are filled in
e The naming was selected from the naming catalog (naming ID is set).

e For an assembly, all components of the first stage must have the same or a higher release
status, or the components must be contained in the same release workflow.

e All revisions have no status (are in ,Working“).
To make a design release, proceed as follows.

Select one or more revisions to be released. These can be individual parts or assemblies.
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Select File » New - Workflow Process... or press Ctrl+P or Ctrl+P on the keyboard.

E My Teamcenter - Teamcenter 12

File Edit WYiew Translation Tools Window Help
Mew > T3, Item... Ctrl+T |
=
[ Open Ctrl+Q | =5 Folder... Ctrl+Alt+F .
= Ooen With -[intDZJ[O0002][IL T LD
pen With... 2 Form.. Ctrl+M
% Openlin MNX -‘,}g., Dataset... Ctrl+Dp  1003.0028 MASCHINENBETT -
:
View Tk URL... f..\| E -
. . _r____-:l--‘-
View With... 2% Workflow Process... _CEE%..P
i Save Ctrl+5 Change.. Worlkflow Process...
a), Savehs % Other.. Ctri+H :
' Revise.. - - - 0032-View .
" & X.0003.0032-01 BEARBEITUNGSZENTRUM &
Close % w [ Use Cases
B Print » [ Create part in Teamcenter
- rfn w |~ Release Processes
Print... v X.0000.0003 PIN
@ Ei Close All » ey X.0000.0003-00 PIN [
X 00030029 MASCHINENBETT v X.0000.0002 HOLDING BLOCK
4B Home [ > = X.0000.0004-00 HOLDING BLOCK |

The workflow ,,FFG 01 Engineering Release” should already be selected. If not, select this workflow
from the list of templates.

No further entries need to be made. However, it is possible to include or remove further revisions as
so-called ,targets” in the workflow. You can also assign a different name and/or a description (but this
is not necessary or usual).
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2 New Process Dialog

uh,

2
Process Mame: %.0000.0003-00 PIM

s

Description: |

Process Template: FFG 01 Engineering Release

# Attachments T2 Process Template Assign All Tasks

T

Process Ternplate Filter: (O Al (®) Assigned

_ Task Attachments
EI Targets

. E-ggf X.0000.0003-00 PIN

}-jj F0000.0004-00 HOLDING BLOCE
[+ References

oK

[
ot

Cancel

P
s

In Teamcenter Navigator, an icon

indicates that an object is in a workflow.

Press OK. If all

conditions are fulfilled, the workflow starts and you can see the started workflow in your inbox

&My Worklist iy the Teamcenter Navigator under {:uc_approvalprocess_en _004.png?nolink|}} ,Task
to be executed”. This is located in the process step ,,Review Selection”.

First open the entry ,,References” and double-click on the form ,,ProcessControlForm®“.
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[ F— a =
&b Home | T3 X.0003.0023 MASCHINENBE... &3 My Worklist 22 = O % Summary 5% (5 Details| . Impact Analysis ==~ Viewer | % JT Preview @3 Process History

G EEE-~ = m Send To... v‘§v|¢f@
v & My Worklist
~ (=1 Doe, John (jdoe) Inbox ProcessCaontrolForm
T Tasks To Perform [ Name: Description:  Release Status: Type:
< X.0000.0003-00 PIN (Review Selection, ProcessCentrolForm Process Control
~ (@ Targels
> &P X00OD.0003-00 PIN €3 Overview| Audit Lags
> @ X.0000.0004-00 HOLDING BLOCK €3 )
5 b X.0000.0003-00 £ - Properties « Preview
5 2 X.0000,0003-00 €3 Name: ProcessCentrolForm
> @ X.0000.0004-00 € Description:
> 23 X.0000.0004-00 £3
~ 1} References Owner: £ Doe John (jdoe) ¥
[# ProcessControlForm Checked-Out:
> & TasksToTiad Checked-Out By: Mo Value 7]
» [ Schedule Tasks
» [ Subscription Messages =
& ProcessControlForm X
®  Process Control ®
Create DWG: = Trye  Falee ~
Create DXF: | Tiye © Falee
CreateIGES:  Trye © Falee
CreateJT: = True  False
Create PDE: — Tope  Falee
Create STEP:  Trje © False
Create TFE: © Toye  Falee
Plant: [g| “.‘ v
General
4 | Check-Out and Edit_2 Close
L

You can now select the desired neutral formats. The default formats are JT and PDF. If the default
settings are sufficient, you can skip this step, otherwise press ,Check-Out and Edit"“.

b ProcessControlForm

Ei Process Control

Create DWG: ® True (O False A
Create DXF: () True (@) False
Create IGES: O True (@) False
Create IT: @® True (O False
Create PDF: ® True () False
Create STEP: (7 Trye (@) False

Create TIFF: @) Trud (O False

Plant: |E| | v|

General

(&

| Saveand Check-ln | | Save || Cancel Check-Out | | Close

Select the neutral formats and press ,Save and Check-In“. Then press the ,Perform Task” button in
the upper bar of the Teamcenter Navigator.
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indow Hel,
a EB-ga TEAMCENTI
(jdoe] - ELFFGY Designm=Lint02 [ [0000ZT[I[ 1L 1Y
— — gEmussmmmas
A Home T A0003.0029 MASCHINENBE... &3 MyWarklist 22 = 5 % Summary & | (& Details| &, Impact Analysis | ae Viewer| % IT Preview | i Process History
o - Send To.. ~

v &% My Workli
v [5) Do, Johh (jdoe) Inbox
w [ Tasks To Perform

X.0000.0003-00 PIN (Review Selection,

Review Selection

Name: Type:

w 1) References

(=) Tasks To Track
Schedule Tasks

[ Subscription Messages

[# ProcessControlForm

<

Task Name: |Review Selection

Review Selection  Condition Task
wv (@ Targets
¥ X.0000.0003-00 PIN £73 L | Overview | Audit Logs
& X.0000.0004-00 HOLDING BLOCK €3 i X
%3 X.0000,0003-00 £ Properties ~ Actions
:J %.0000.0003-00 € Desciiption: [ Perform
% X.0000.0004-00 £
_"_: i ’ -x’: ¥ Perform Condition Task o B passign...

Task Instructions:

Process Description:

Comments:
Task Result: O Peer Review Self Review
() unset
oK Cancel
T T AddNew PR CiEI nCanu | [ Packe |

T =]

A menu opens in which you can select whether a self review or a peer review is to be performed.

Press ,Self Review”. No further steps are necessary. In the entry ,Tasks to Track” you can track the
workflow or the different tasks, e.g. you can see the subprocesses of the neutral format generation.

A» Home| @ X.0003.0029 MASCHINENBE... | &% My Worklist 52— O
Q| =

v & My Worklist
~ |71 Doe, John (jdog) Inbox

Perform

Track

v |5 Ta
o X.0000.0003-00 PIN (Drawing to DWG)
2o X.0000.0003-00 PIN:1 (Create DWG)
[ X.0000.0003-00 PIN (Drawing to PDF)
= X.0000.0003-00 PIN:1 (Create PDF)
[ X.0000.0003-00 PIN (Drawing to TIFF)
2o X.0000.0003-00 PIN:1 (Create TIFF)
[ X.0000.0003-00 PIN (Model to JT)
2o X.0000.0003-00 PIN:1 (Create JT)
=1 Schedule Tasks
|==1 Subscription Messages

cks To

In the Teamcenter Navigator, a symbol xxxxxx indicates that an object is in a workflow. This means
that the object is write-protected, changes are not possible.
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v @ X.0000.0003 PIN
v @ X.0000.0003-00 PIN €7
I3 View
] X.DD00.0003-00-1
z X.0000.0003-00 £7
%2 X.0000.0003-00 &3
& X.0000.0003-00 €3
[ SAP Transferform
v @ X.0000.0004 HOLDING BLOCK
v @ X.0000.0004-00 HOLDING BLOCK €
I3 View
] X.DD00.0004-00-1
z X.0000.0004-00 £7
% X.0000.0004-00 &3
& X.0000.0004-00 €3
[ SAP Transferform

As soon as the workflow is completed, the release status (in this case ,,ER") is displayed as an icon
and text on the objects. In addition, the generated neutral formats are attached to the revision as
datasets and have also been released.

4 | Release Processes
a TP X.0000.0003 PIN | BOLZEMN
4 -jﬁ #.0000.0003-00 PIM | BOLZEM ER
- [5g Ansicht
- | X.0000.0003-00-1 ER
- T X.0000.0003-00 ER
. 7 X.0000.0003-00 ER
- {1 x.0000.0003-00-1 ER
s wﬁ ¥.0000.0003_00_Sheetl_2d ER
- | X.0000.0003-00-1 ER
. & X.0000.0003-00 ER
ER ER
[ SAP Transferform
) -jj #.0000,0003-01 PIM | BOLZEM
» [ﬁ Basierend auf der Beziehung
4 T X.0000.0004 HOLDIMG BLOCK | HALTEKLOTZ
» -jﬁ X¥.0000,0004-00 HOLDIMNG BLOCK | HALTEKLOTZ ER
4 -jj #.0000.0004-01 HOLDIMG BLOCK | HALTEKLOTZ ER
s [ﬁﬁmsicht
. 7 X.0000.0004-01 ER
. % ¥.0000.0004-01 ER
- | X.0000.0004-01-1 ER
» ") X.0000.0004_01_Sheet1_2d ER
-y X.0000,0004-01 ER
- {74 X.0000.0004-01-1 ER
. wﬁ A.0000.0004 01 _Sheetl 2d ER
. & X.0000.0004-01 ER
ER ER
[27 SAP Transferform
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8.2.1 Enable with Reviewer

When releasing according to ER, you also have the option of specifying a ,Reviewer”, i.e. releasing
according to the ,4-eye-principle”. To do this, select ,Peer Review" instead of ,Self Review" in the
release dialog.

| &
o

i
Task Name: |Review Selection

Task Instructions; E

Process Description:

Comments:

| mpmemmm==
Task Resultw () Self Review L

) unset

QK Cancel
L LRI |

In the following dialog you can now select a ,Reviewer”. The possible reviewers are preset, usually a
person with the role ,design admin“ in the same group (,,construction responsibility“) as the person
who starts the workflow.

Press the , Perform” button in the menu bar.

Select a person from the right field of the , Organization” (in this case Doe, John (jdoe)), press ,Add".
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Actions  Window H
828 g a
(Doe, John (jdee] - ELFFG Mesign “Hatl2 [[O00021[10 1 [ D
- = [ @gEs=ssoas

% (A Home @\H{me ggw‘mnkﬁﬂ\sz

Q| EEE-~~

¥ Summary 53 ngDeta\Is f’, Impact Analysis | =e Viewer 5 JT Preview @Proce;; History

:l . v & My Workli
- w |5 Doe, lohn €] Inbox
Customize w [ Tasks To Perform

» X.0000.0003-00 PIN (seled—signoH:tEam

(5 Tasks Te Track
7] Schedule Tasks
|5 Subscription Messages

Close All

Clear

e 2 o»

select-signoff-team
Name: Type:

lect Sinnnff Team Tack

celect-cinnnff-team

& Select Signoff Team x
7Y | S
B_? Si' noff Team Reqy [ Profiles - EL.FFG/Design-Admin/1
=- &l Profiles EJ’
= Organization Project Teams
-5 Address Lists -
SR 2
-5 Design-Admin
a, Barner, Harti (hbarner)
< > :&, Bartkowiak, Jan (jbartkowiak)
. &, Bauer, Karin (kbauer)
Process Description: Deess Marcel (mdesss) E—
i_Doe John fidoe] A
< >
Resource Pool Options FE—
Review Quorum @) Any Member (O All Members
® Numeric 1 O Percent % ® Specific Group Amy Group
Comments s Enter User ID or User Name |
I Enter Role Name Q @
S Enter Group Name
=
[] Wait For Undecided Reviewers [ Required P
v W& Ad-hoc done it
oK Apply Close FE—

r‘l Check Out.. Check In., Save and Feep Checked-Out  Cancel Checkout.,

The person is added to the Signoff team and is selected as the releasing person. You can now press

»,OK" to complete your entries.
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Actions Window Help
SSRGS -EA
(Doe, John (jdee) - ELFFG / Design - [int02 J[O00021 (1011 D)

& 4B Home A&k Home &5 My Worklist 53

Q| EEE-~~

- = g

¥ Summary 53 E‘]‘Deta\ls

+
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Impact Analysis | =e Viewer 5 JT Preview :B Process History

select-signoff-team

~ v & My Worklist
:l e ~ (7 Doe, John (jdoe) Inbox
Customize w [ Tasks To Perform
» > EFX.CHII].CI]B—CIJ PIM {select-signoff-team)
(=) Tasks Te Track
» 7] Schedule Tasks
» |5 Subscription Messages
=
)
)
Close All
Clear
B s

Name:

celect-cinnnff-team

Type:

lect Sinnnff Team Tack

& Select Signoff Team
iy

&

Ej’ Signof‘FTeam
El&_l Profiles
=R [.rrG

esign-Admin/1

T8 Address Lists

<

Organization

Project Teams

Process Description:

&g Bl
-5 Design-Admin
& Barner, Harti (hbarner)
#_ Bartkowiak, Jan (jbartkowiak)
&, Bauer, Karin (kbauer)
'-*, Deess, Marcel (mdeess)
& Doe John fidoel

<

Review Quorum

(® Mumeric |1

Comments

[] Wait For Undecided Reviewers

v W& Ad-hoc done

() Percent %

Resource Pool Options
®) Any Member (O All Members

(®) Specific Group

Any Group

s Enter User ID or User Name

I Enter Role Name
%

Enter Group Name

[] Required

Add

IHI Check Out.. Check In., Save and Feep Checked-Out  Cancel Checkout.,

The releasing person now receives the task in his/her ,Inbox."

As the person who has released the task, select the task and press the ,,Perform” button in the menu

bar.
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Actions  Window H,
LOE 8 & @ -iga
(Dwaluhn(JdUE)-EI-FW[WﬂHl 10n
q|E ARy v =0 '*"s:r?r'na'r;'ﬁ £ Details| % Impact Analysis | o= Viewer | % JT Preview | @3 Process History

& @HDA{ &% Home @W &3

~ ., John (jdoe) Inbox (1)

Customize v Tasks To Pe

» <Z_ Ll X.0000.0003-00 PIN (perform-signoffs) >

| Tasks To Trac
I Schedule Tasks
I Subscription Messages

Close All

Clear

_ perform-signoffs
< Name: Type:
perform-signoffs  Perform Signoff Task

Q Perform Signoff

Process: X.0000.0003-00 PIN State: ¥E Started

Process Description: ‘ ‘
Review Task: Review El

Quorum: 1 Wait For Undecided Reviewers: false
Responsible Party: Doe, John (jdoe

For Review: Attachments All Comments

Instructions:

‘Signoﬂtaam perform their signoffs. ‘

User-Group/Role Required Decision Comments
Doe. John (idoe)-ELFEG/Design-Admin ~ No

Date

Close

W rrerr e rherk In

Save and Keen Cherlbad-Not

Canrel Charkant

In the following dialog press ,Decision”. Another dialog opens, in which you can confirm (,,Approve*)

or reject (,Reject”) the release.

Press ,Approve*“.

signoffs) T Name:
S ] Signoff Decision x
perform-signofi
Q Perform fF
Process: X,0000.0003-00 PIN State: §E Started Decision Comments:
Process Description:
Reject
Review Task: Review EI
Quorum: 1 Wait For Undecided H No Decision
Responsible Party: Doe, John (jdoe { w
For Review: Attachments All Comments / Q OK) Cancel
Instructions: Signoff team perform their signoffs. / |
1
ser-Group/Rol uir: lecision mments ate
User-Group/Role Required Deci Co D;
Doe. John (idoe)-ELFFG/Desian-Admin ~ No

L UL TSI

The decision is displayed in gre

Close
Cherk In.. Save and Keen Cherked-Chut Canrel Cherknot..

en, you can close the dialog with , Close”.
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i Perform Signoff x

Process: X.0000.0003-00 PIN State: 'ﬁ Completed

Process Description:

Review Task: Review El
Quorum: 1 Wait For Undecided Reviewers: false
Responsible Party: Doe, John (jdoe
For Review: Attachments All Comments
Instructions: Signoff team perform their signoffs,
User-Group/Role Required Decision Comments Date

Doe, John (jdoe)-ELFFG/Design-Admin Mo @ 23-Jul-201915:16

Ceoe D

The release process now continues in the background, as a result the neutral formats are generated
and released together with the revision(s) of the workflow to the status ER.

8.3 Engineering Release (release after "Er") for parts with
AutoCAD drawing

The approval process of a part with an AutoCAD drawing is essentially identical to the approval
process of all other parts. The only difference is that a Tiff is always generated from the AutoCAD
drawing.

To release such a part select one or more revisions and select ,File - New —» Workflow Process...” or
.Ctrl+P*“ or ,Ctrl+P*.

In the following dialog select the workflow ,FFG 01 Engineering Release”, if it is not already selected.
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ﬁ Mew Process Dialog
4:@

s

Process Name: | %,0000.0005-00 MAIN SPINDLE

Description: |

Process Template: |FFG 01 Engineering Release

Process Template Filter: (O All (@) Assigned

# Attachments TS Process Template Assign All Tasks

. Task Attachments

EI . Targets

: 9 X.0000.0005-00 MAIM SPINDLE
References

B & B B

. 0K || Cancel |
u
Press , OK“.
@ My Teamcenter - Teamcenter 12
File Edit View Translation Tools Actions Window H
HABEIR DSOS 9 @ ig-iga
@~ @~ My Teamcenter (Dos John (jdos) - ELFF sign - [int02 ][ 0000Z][1[ 1 1)

Quooao

5 apmn
- =0 * Summary Datails _g_lmpact... s

Search Text QLB | Where: |—F
»| =
< X.0000.0005-00 MAIN SPINDLE (Review ¢

Where Referenced Options (Applicable for

Type: Relation: [
| _——

& Revi

e

& 23 Nom®\ &b My Worklist 22 Q| EEmHa >
« Search
w
|Enterthe ltem |D to search | n -
= Quick Links Customize
&k Home »
& My Worklist »
ETMy Projects »
@ Ity Links b
4 My Saved Searches b
5 My View/Markup » ® Perform Conditok
<
~ Open ltems Close Al \
Task Name: g, Selbcti
5 My Worklist Review &QE""
b Home Task Instructions: \
Process Description: ‘
Comments:
= History Clear
Task Result: () Peer Review
Q Getting Started O unset
{ii) My Teamcenter
IE Structure Manager

Select the new task in your inbox and press the ,Perform Task" button.

FI'P
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In the following dialog select ,Self Review” and press , OK".

i# Home 2 %% My Worklist | g X.0000.0005-00 MAIN SPINDLE = O
] 0 FH F A=
~ &k Home
8 Mailbox
=) Newstuff

T X.0003.0032 BEARBEITUNGSZENTRLUM
w | Use Cases
[51 Create part in Teamcenter
=1 Release Processes
v [ AutoCAD
~ TP X.0000.0005 MAIM SPINDLE
v g X.0000.0003-00 MAIN SPINDLE ER
lj Wiew
;ﬂ X.0000.0005 ER
"l X.0000.0005 ER
ER ER

After a while the revision and the AutoCAD dataset get the status ,ER" and a TIF file was created
which also got the status ,ER".

8.4 Serial release (release after "SE")

When you release a series, that is, release it to status SE, the data is transferred to SAP. The material
master, structure (if available) and documents (info records and files) are transferred.

The series release can be started by any designer. This means that a person from the same group (for
example, ,EI“) with the role ,Design-Admin“ must approve the release.

After the serial release, a part can no longer be changed except by administrative intervention.

During release, certain conditions are checked, without which the workflow does not start. Condition
for a series release are:

e |t's an object of the FFG EngltemRevision type.

¢ All mandatory attributes are filled in

e The naming was selected from the naming catalog (naming ID is set).

e For an assembly, all components of the first stage must have the same or a higher release
status, or the components must be contained in the same release workflow.

e All revisions to be released do not already have the status ,SE“.

To make a series release, proceed as follows:

Select one or more revisions to be released. These can be individual parts or assemblies.

ol Note:
&
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. You can select the revisions both in the ,Teamcenter Navigator” and in the , Structure
Manager“. In this example we will make the selection in the ,Structure Manager“.

Select ,File » New - Workflow Process...” or press Ctrl+P or Ctrl+P on the keyboard.

E——
[# Structure Manager (% =
X.1200.0012-00 COLUMN | STAENDER. (View) - Latest Working - Date - "Now"
BOM Line [Rule configur..| ttem Rev Status Find No. Quantity | Unl{ @ variants % Graphics | % Referencers %o Supersedure 4 Attachments
[ & * X.1200.0012-00 COLUMN | STAENDER (View) — )
“f7 @/ X.1200.0013-00 TOOLHOLDER | STAHLH... Working( ) 10 cac JJW‘? ‘N 4 ‘@l @ B 5 & 1o ‘@ % = ‘ ¥ |C} |E| ‘
1V & %755 X.1200.0014-00 STAENDER (View) Working( ) 20 eac
. ¥ 0 X1200.0015-00 STTNDER Working( } 10 eac
~[7 & # X.1200.0016-00 PANEL | MONTAGEBLE... Working( ) 30 eac
“[7 @/ X.1200.0016-00 PANEL | MONTAGEBLE... Working( ) 0 eac
¥ @ 4 X.1200.0017-00 PIN | EOLZEN Working( ) 50 eac
-[# @ X.12000017-00 PIN | BOLZEN Working( } &0 eac
LfF @ # X.1200.0013-00 TOOLHOLDER | STAHLH... Working( ) 70 eac
x\L
=
< >

The dialog for creating a new workflow opens.

Structure Manager 7
<5

X.1200.0012-00 COLUMM | STAENDER (View) - Latest Working - Date - "Mow"

[ BOM Line [ Rute configur...| ttem Rev Status Find No. | Quantity | Unu @ Variants T Graphics | ¥ Referencers % Supersedure & Attachments
[ & * X.1200.0012-00 COLUMN | STAENDER (View)
L7 &/ X.1200.0013-00 TOOLHOLDER | STAHLH... Working( )
=% @ .7} X.1200.0014-00 COLUMN | STAENDE... Working( ) |
| @+ T X1200.0015-00 MACHINE COLU... Working( )

& Mew Process Dialog I} X

[y Process Name: ¥ ®

" [7 @ X1200.0016-00 PANEL | MONTAGEBLE... Working( ) rocess Mlame: X.1200.0014-00 COLUMN | STAENDER

¥ @ ¥ X.1200.0016-00 PANEL | MONTAGEBLE... Working( ) Description: | |

L @ # X.1200.0017-00 PIN | BOLZEN Working( )

l d Process Template: |FFG 03 S b

7 & # X1200.0017-00 PIN | BOLZEN Werkingt) G plte| res__D Bl

= @ # X1200.0013-00 TOOLHOLDER | STAHLH... Working( ) Process Template Filter: (O All @) Assigned

# Attachments 72 Process Template Assign All Tasks

| Task Attachments
-] | Targets L
| G-@F X.1200.0014-00 COLUMN | STAENDER
| G-@f X.1200.0015-00 MACHINE COLUMN | MASCHINENSTAENDER
References
-

¥

2 E B @E

4 + ( oK > Cancel

Select the FFG 03 Series workflow and press OK. No further input is required. However, it is possible
to include or remove further revisions as so-called ,targets” in the workflow. It is also possible to
assign a different name and/or a description (but this is not necessary and also not usual).
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6 If not all mandatory attributes have been filled in, a corresponding message is displayed
and the workflow is not created.

l:# Error

@ Business rules for handler 'TCPB-RH-checkObject' on action 'Start’ in task 'FFG 03 Series’ are not
met.

TCPB-EH-checkForm: Ben.lD d

Business rules for handler 'TCPB-RH-checkObject' on action 'Start’ in task 'FFG 03 Series’ are not met,
TCPB-RH-checkForm: not all mandatory values filled in Ferm(s), See further entries below: (2]
TCPB-RH-checkForm: Freigabe gines Mormteils ist hier nicht erlaubt, | Cannot release a standard part.
nicht leer sein, | Cat.lD must not be empty. (2]
TCPB-RH-checkForm: Produktline darf nicht leer sein. | PL must not be empty.

TCPB-RH-checkForm: Q-Code darf nicht leer sein, | G-Code must not be empty,
TCPB-RH-checkForm: Beschaffungsart darf nicht leer sein. | Make OrBuy must not be empty.

In this case, you can make any necessary changes and restart the workflow.

If all conditions are met, the workflow starts and you can see the started workflow in your inbox in the
Teamcenter Navigator under , Tasks to Perform“. This is located in the ,Review Selection” process

step.

First open the ,References” entry and double-click on the ,ProcessControlForm* form.

&% Home © Search | &3 My Worklist 5 ™ X.0000.3414 STAENDER

= [ 4p=ssomman

¥ Summary &3 | [ Details| ¥, Impact Analysis == Viewer % JT Preview 3% Process History

v & My Worklist
w [ Doe, John (jdoe) Inbox
) Tasks To Perform
v @’X.TZDD.DDT4—DD COLUMM | STAENDER (select-signoff-team
v (@ Targer
& X.1200.0014-00 COLUMN | STAENDER €3

i X.1200.0014-00 €3
% X.1200.0014-00-dwg1 €3
% X.1200.0015-00-dwg1 €7
G X.1200.0015-00 €
{2 X.1200.0014/00-View £3

~ 2] Reference
|4 ProcessControlForm

AlEEE -~ b

& X.1200.0015-00 MACHINE COLUMM | MASCHINENSTAENDER £

[ Name:

ProcessControlForm

ProcessControlForm
Description:  Release Status: Type:

~ | SendTo.. ~| B

Overvi ew} Audit Logs|

+ Properties

Name:

ProcessControlForm

* Preview

& ProcessCentrolForm

[ Tasks To Track
[ Schedule Tasks
() Subscription Messages

Control Flag 0:
Create DWG:

X
B Process Control *®

~

True False
Create DXF: True False
Create IGES: True False b
Create JT: True False
Create PDF: True False
Create STEP: True False
Create TFF:  Trpe o Falee
Plant: || | | ’
General
=)
G
= iy =

You can now select the desired neutral formats. The default formats are JT and PDF. If the default
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settings are sufficient, you can skip this step, otherwise press ,,Check-Out and Edit".

& ProcessControlFarm

x
B Process Control w

Create DWG: @® True (O False A
Create DXF: () True @) False
Create IGES: O True @ False
Create JT: @ True () False
Create PDF: @) True () False

Create STEP: (O True (@ False

Plant: |E| | | w
General
i
Save and Check-In Save Cancel Check-Out Close
Select the neutral formats and press ,Save and Check-In“.
Then press the ,,Perform Task” button in the upper bar of the Teamcenter Navigator.
Actions  Window Hel
SHE 8% TH-@a TEAMCEN

(Doe, John (jdoe) - El.ﬁ/ Desigr™=hint02 ] [00002]1 (111 [ 1)

——
¥ &b Home (3 Search gMyWolklisl bl | XWTAENDER =0 [¥ Summary Data\\s & Impact Analysis| == Viewer 2 IT Preview @Process History

-~ =1l =
v & My Worklist | & select Signoff Team x
~ =) Dog, John (jdoe) Inbox &

X.1200.0014-00 COLUMN | STAENDER. (select-signoff-team!

v @ Tagels i Signo‘ﬁ'?mm\‘ Required ||| Profiles - ELFFG/Design-Admin/1
- : M ) L
> @ X.1200.0014-00 COLUMN | STAENDER 3 Profilee  — —————————___ - [&" Profile signoffs met,
= - oY e A — |
» ;‘ X.1400,0015-00 M:QCH\NE COLUMN | MASCHINENSTAENDER € "~ Doe ot (dos] - ELFFG/DesgmoAdmin [ ] \ Onganization | Prject Teams
> g X.1200.0014-00 €3 -8 Users
> [ X.1200.0014-00-dwg1 €3 -5 Address Lists ™ -k Design-Admin ~
> 7 X.1200.0015-00-dwg1 £ L i el
> Ty X1200.0015-00 €3 b mwmm w e
5 {2 X.1200.0014/00-View £ = e e
~w 1) References

[Z7 ProcessControlForm ~-&._ Doe, John (jdoe)
» [ Tasks To Track

< >

» [ Schedule Tasks b Descri ) b ol B el ™
> [ Subscription Messages rocess Description: (R [FER = =8
R e e
< >
Resource Paol Options
Review Quorum (® Any Member (O All Merbers
® Numeric |1 O Percent % Specific Group Ayl Group
Comments Entgr User ID or User Nathe
&[S
[ Wait For Undecided Reviewers [ Required

v W& Ad-hoc done

Apy

A menu opens in which you can select a reviewer/releaser. The workflow ensures that this person can
only be selected from your own group (KV) and has the role ,,Design-Admin*“.

Select a person in the right menu window under ,Organization” and press ,,Add“. The person is
assigned to the profile in the left menu window and the ,,OK" button is activated.

Press ,,OK". The window closes and the task is completed.

The following tasks are performed by the person selected to release the revisions. This person
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receives a release request by e-mail.
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Actions Window Help
cazaefaye-aa TEAMCENTER
(Due,Juhn(Jdoe)—El‘FﬂG[Deslg nt02 ] (00002101011 D)
- susssusESE .
# ki Home €, Search $Myw‘nk\ist = W}AMSTAENDER 5 % Summary 57 | Details | &, Impact Analysis | oo Viewer | 2/ IT Preview | & Process History
1 & pecom x B
v & My Worklist
~ [ Doe, John (jdosklabe Process: %.1200.0014-00 COLUMN | STAENDER state: {F Started
[ Tasks To Perform Process Descriotion:
1200.0014-00 COLUMN | STAENDER (perfarm-signol rocess Desaphion: |
v g
& X.1200.0014-00 COLUMILY STAENDER £ Review Review EI
& X.1200.0015-00 MACHINE COLUMM | MASCHINENSTAENDER € Quarum: 1 Wait For Undetided Reviewers: false
2 00 £
e X.1200.0014-00 £ Party: hn (jdoe)
7 X.1200.0014-00-dwg1 £
%2 %.1200.0015-00-dwg1 £ For Review: Attachments” All Comments
T %.1200.0015-00 £ Instructions: Signoff team perform signoffs,
{7 X.1200.0014/00- View £
~ 1] References
[2# ProcessControlForm User-Group/Role Required hﬁsion Comments Date
5 Tasks To Track Dee, John (idoe]-ELFFG/Design-Admin Ne
(51 Schedule Tasks
(51 Subscription Messages
& Signoff Decision %
v
Decision Comments:
) Reject
(O No Decision
) | oK Cancel
I' I Object

Select the task in the worklist under , Tasks to Perform*.
Press the button ,Perform Task" in the upper menu bar.
In the following dialog press ,No Decision”.

In the following dialog, section ,Approve” and then ,OK".

SR U 4R AT A AR CALHIARE ] ETARRIRER £
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i Perform Signoff *

Process: ¥.1200.0014-00 COLUMM | STAENDER State: ﬁ Completed

Process Description:

Review Task: Review EI

Quarum: 1 Wait For Undecided Reviewers: false
Responsible Party: Doe, John (jdoe

Far Review: Attachments All Comments

Instructions: Signoff team perform their signoffs.

User-Group/Role Required Decision Comments Date

Doe, John (jdoe)-ELFFG/Design-Admin Mo e 02-0ct-2019 11:34

The workflow now continues. After a short while, the ,Approve” decision is displayed in green (or red
for ,Reject”). You can now close the dialog with , Close”.

Under ,My Worklist = Tasks To Track” you can follow the workflow. In this example the neutral
formats are created.

&k Home | ©) Search &% My Worklist 52 T X.0000.3414 STAENDER = 0O

L o

1
v &l My Worklist
w |7 Doe, John (jdoe] Inbox
|3 Tasks Te Perform
w | Tasks To Track
[ %.1200.0014-00 COLUMN | STAENDER (Drawing to PDF)
aer X.1200.0014-00 COLUMN | STAENDER:1 (Create PDF)
2ok X.1200.0014-00 COLUMN | STAENDER:1 (Create IT)
E ¥.1200.0014-00 COLUMN | STAENDER (Model to JT)
=1 Schedule Tasks
51 Subscription Messages

After the workflow has been completed, the creator of the workflow receives a notification by e-mail
and the parts have the status ,SE".

The status is displayed in the column ,Item Rev Status“ in the structure manager.
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= E

[ Structure Manager 5%

X1200.0012-00 COLUMN | STAENDER (View) - Latest Working - Date - "Now"
i BOM Line | Rule configur...] Item Rev Status Find No. Quantity [ Unl{ @ variants % Graphics ¥ Referencers % Supersedure 4 Attachments
Vg %, X.1200,0012-00 COLUMN | STAENDER (View) = = — .
114% & X.1200,0013-00 TOOLHOLDER | STAHLH... Working( ) 10 ead[ || D Ml EEE |0 | Aul=d o5 3
1 & %77 X1200.0014-00 COLUMN | STAENDE... Working( ) 20 eac
| ¥ @ o7 X.1200.0015-D0 MACHINE COLU... Working( ) 0 esc
W@ X1200.0016-00 PANEL | MONTAGEBLE... Waorking( ) 30 esc
9 @ # X1200.0016-00 PANEL | MONTAGEBLE... Waorking( ) I ea
i @ ¥ X1200.0017-00 PIN | BOLZEN Working( ) 50 e
7 @ ¥ X1200.0017-00 PIN | BOLZEN Working( ) 50 e
| W & J X1200.0013-00 TOOLHOLDER | STAHLH... Working( ) i exc
F)
V___ =
< >

In the Teamcenter Navigator, the status is displayed as an icon on all released objects.

v T X.1200.0014 COLUMN | STAENDER
{2 ¥.1200.0014-View
v @ X.1200.0014-00 COLUMN | STAENDER SE
g View
7 X.1200.0014-00 SE
% X.1200.0014-00-dwg1 SE
7 X.1200.0014-00-dwg1 SE
& ¥.1200.0014-00 SE
©{; X.1200.0014/00-View SE
SE SE
[Zr SAP Transferform

8.5 Changes and release after changes

If a part that already has series release is to be released again after a change, a change notice is
required. In general, this is also referred to as a change.

However, a part can be revised without a change and can also be released with the status ER.

To make a change to a released part, first create a new revision. To do this, select an existing revision
and then choose ,File -» Revise..."”.
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@ My Tearncenter - Tearncenter 12

File Edit Wiew Translation Tools Window Help

New 1A &0
[lf—l' Open Ctrl+Q ) ) )
(jdoe) - ELFFG / Design - [int02 J[O0002 T[T 10 DD
Open With...
& OpenlinNX e &5 Ap Home f-‘§5~|E|“" v = 0
@ Open In Lifecycle Visualization b Home
View b ‘ Mailbox
Vi Mewstuff
View With... ¢ [ Use Cases
E] Save Chrl+S » |5 Create part in Tearmcenter
w | Release Processes
— s 5 1@ X.0000.0003 PIN | BOLZEN
» T X.0000.0004 HOLDIMG BLOCK | HALTEKLOTZ
Close » T X.0000.0007 INDEX TABLE A-AXIS
> T X1200.0001 TROUGH | ABFLUSSRINME
=5 Print » T X1200.0012 COLUMM | STAEMDER
Frint... » T X1200.0015 MACHIMNE COLUMM | MASCHINEMSTAENDER
» T X1200.0014 COLUMM | STAEMDER
@ Exit o ¢ ECN-D0000T Demo-Change
b Favorites Organize » T X.1200.0018 PIM | BOLZEN
w T X1200.0020 COLUMM | STAENDER
» IWant To... Customize ¥.1200.0020-Vi
¥.1200.0020-00 COLUMMN | STAENDER SE Y
» [ﬁ‘u’iew

> i X.1200.0020-00 SE

> ¥ X.1200.0020-00-dwg1 SE
> X.1200.0020-00-dwg1 SE
>
>

= ¥.1200.0020-00 SE k
B{ X.1200.0020/00-View 5E ]
SE SE
The revision dialog opens.
& Revise FFG Engineering Item Revision O ot

Object Revise information

X.1200.0020-00 COLUMN | STAENDER

Revision: p1 W

English: | COLUMN |

fnd0CheckoutOnRevise: () True () Falze

[] Open On Create

< Back Mext = ( Finizh Cloze

22/32 Printed on 2025/08/25 03:09



23/32

Printed on 2025/08/25 03:09

Press ,Finish* without further input. In this example, revision 01 was created.

v "3 X.1200.0020 COLUMN | STAENDER
a2 X.1200.0020-View
v @ X.1200.0020-00 COLUMN | STAENDER SE

g View

T X.1200.0020-00 SE
2 X.1200.0020-00-dwg1 SE
{1 X.1200.0020-00-dwg1 SE
& X.1200.0020-00 SE
{7 X.1200.0020/00-View SE

5E SE

¢ ¥.1200.0020-01 COLUMN | STAENDER

g X.1200.0020-01

2 %.1200.0020-01-dwg]
{ X.1200.0020/01-View
[2F SAP Transferform

The model (UGMASTER) and the drawing (UGPART) are copied during revision. Please note that
neutral formats such as PDF or JT are not accepted. These will be recreated if necessary or at the

latest at release.

In order to release the new revision to the status ,SE“, a change must exist. The creation of changes
may require certain additional permissions under certain circumstances.

Select ,File » New - Change...".

& My Teamcenter - Teamcenter 12

File

Ok

@

B0 B

1]

Edit View Translation Tools

Mew

Open

Open With...

Open In NX

Dpen In Lifecycle Visualization
View

View With...

Save

Save As

Revise...

Close

Print
Print...

Exit

Window Help

> TR ltem.. Ctrl+T
Ctrl+© 2% Folder... Ctrl+ Alt+F
% Form... Ctrl+M
Y4, Dataset... Ctrl+D

% URL...
*#% Workflow Process... Ctrl+P
curles Other... Ctrl+H

¥ X.0000.0003 PIM | BOLZEM

3 .0000.0004 HOLDING BLOCK | HAL

3 .0000.0007 INDEX TABLE A-AXIS

3 31200.0001 CASTING | ABGUSS

¥ ¥.1200.0012 COLUMM | STAEMDER

9 1200.0015 MACHINE COLUMM | K
w T X.1200.0014 COLUMM | STAEMDER

=5 X.1200.0014-View

The change number is automatically assigned by Teamcenter. The attributes , Overview" and
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~Description” are mandatory attributes and must therefore be filled in.

&% New Change O = 0

Change Iltem Create Information I

Define change item create information

T

& Change Notice

I} General Information
+ Properties (required)
ECM Mumber: | |
Revision:
Synopsis® | Demo-Change |
Dernonstrate the change process in
Description:* Teamcenter|

(] Open On Create

< Back Mext = Close

Enter any values for ,Synopsis” and , Description” and press ,Finish“.

w o a ECH-D00008 Demo-Change
w ¢ ECN-D00002-A Demo-Change
[ﬁ Problems
[ﬁ Impacted
[ Solutions
I3 Change References

[ﬁ Plans

[ﬁ Implements

If you selected a folder, the Change object is inserted here. Otherwise the Change can be found in the
Newstuff folder.

8.5.1 Adding participants

In order to be able to work on a change, you must be assigned to it as a participant. The person who

24/32 Printed on 2025/08/25 03:09



25/32 Printed on 2025/08/25 03:09

created the change can assign participants with different roles to it. For the sake of simplicity, we at
FFG will only use the role ,,Change Contributor”.

Select the revision (!) of the Change object and choose , Tools = Assign Participants...”.

@ My Teamcenter - Tearncenter 12

File Edit WView Translation Toeols Window Help

R+ B E|X|E] Check-In/Out > [@~iE 0
&~ -~ My Teamc Project * FG/ Design-[intD2 {00002 101111 1)
I rt ¥
mpo "%|E|“' - =
~ Search T ’
|Entr=r the ltem 1D to search | | Reports ¥
- Quick Links o TZ Assin Participents...
w g%se Cases
e
gHume ] » |1 Create part in Teamcenter
My wu_rkhgt w |7 Release Processes
EImy Projects ” 9 X.0000.0003 PIN | BOLZEN
& My Links ” 9 X.0000.0004 HOLDING BLOCK | HALTEKLOTZ
*‘f_a My Saved Searches » 9 X.0000.0007 INDEX TABLE A-AXIS
% My View/Markup » 9 X.1200.0001 CASTING | ABGUSS
9 £.1200.0012 COLUMMN | STAENDER
» Open ltems Cloze All 9 £.1200.0015 MACHINE COLUMN | MASCHINENSTAENDER.
» Histo v @ X.1200.0014 COLUMMN | STAEMNDER.
v Clear a{7 X,1200.0014-View
» Favorites Organize & X.1200.0014-00 COLUMM | STAEMDER. SE
& X.1200.0014-01 COLUMM | STAEMDER.
+ I Want To... Customize [ﬁ Based On Relation
w s ECN-000007 Demo-Change
ECM-000007-A Demo-Change >
ﬁ Problems
[ﬁ Impacted
ﬁ Solutions
[ﬁ Change References
[ﬁ Plans
[ﬁ Implerments

The dialog for assigning persons known from the release process opens.
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& Assign Participants >
._":l,__'l Participants Change Contributors
k2 o]

ICI] A
Change Contributors

ﬂ-‘ﬁ Change Implementation Boar
-8 Change Specialist |

-8 Proposed Responsible Party
-8 Proposed Reviewer

-8 Regquestor

i }

Organization

Project Tearns

ﬁ Organization
=& FFG

=8 TS
=55 Design

“ 8 Dog John (jdoe)

n (jdoe)

) [

Remowve

OK

Apply

Cancel

Select a person with the role ,,Design” from the organization and add them to the Change as ,Change
Contributor” with ,,Add”. If necessary, repeat the process for other persons.
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&2 Assign Participants

Y

C_;l Participants

Doe, John (jdoe)-ELFFG/Design
88 Change Implementation Board
-8 Change Specialist |

ﬂ Proposed Responsible Party
'Eb Proposed Reviewer

-8 Requestor

Change Contributors
= &

Organization  Project Teams

Printed on 2025/08/25 03:09

>

E COrganization
=& FFG

E EIEE. Design

: E Doe, John (jdoe)
£ Design-Admin
E Deoe, John (jdoe)

Fﬂ

-
5 5

& &

£ Design
E Deoe, John (jdoe)

Resource Pocl Options

(O] Any Member () All Members

(®) Specific Group () Any Group

8 |jdoe
Enter Role Mame

o
& |Enter Group Name

Add Modify

Apply Cancel

L 2]

Remove

Then press ,,OK".

8.5.2 Solution Items and Problem Items

A change is used to track changes under a common change number. Due to changes, so-called
»solutions” are created and assigned to the change. The items to be changed (i.e. those that cause
~problems”) are assigned to the change as , problems”. In this example, revision 00 is a ,,problem”
and revision 01 is the ,solution”. New parts that do not have a previous revision can also be created

as part of a change.

To add ,Solutions” and ,Problem* to the change, copy the corresponding revisions and paste them
into the (pseudo) folders ,Problems*” and ,Solutions*”.
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~ s ECN-000008 Demo-Change

v I ECM-D00002-A Demo-Change

~ | Problems

éij X.1200.0020-00 COLUMM | STAEMDER SE

[@ Impacted

W ﬁ Solutions

_-53 X.1200.0020-01 COLUMM | STAENDER

I=¢ Change References

[ﬁ Plans

[ﬁ Implements

Then you can release the ,Solutions”. Note that it is not the Change itself that is released, but the

,Solutions” it contains.

8.5.3 Start of the release process

To release, select one or more revisions of the ,Solutions” and press ,,Ctrl+P* or ,Ctrl+P*.

i New Process Dialeg
*::.u

Process Mame: |¥,1200.0020-01 COLUMMN | STAENDER *

Description: |

Process Template{ FF5 03 Series With Change &

# Attachments 7= Process Template Assign All Tasks

Process Template Filter (O Al (®) Assigned

. Task Attachments

EI . Targets

- B X.1200.0020-01 COLUMM | STAENDER
o References

2 & B E

0K Cancel

Now select the workflow ,,FFG 03 Series with Change®.

The rest of the procedure is the same as for series release.
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&k Home | &k Home & My Worklist 52

v &% My Worklist
v [ Doe, John (jdoe) Inbox (1)

v orm

(.-\|E| == 0

Printed on 2025/08/25 03:09

daoaaaaaa

> E\j‘ ®.1200.0020-01 COLUMN | STAEMDER (select-signoff-team)

SRES

51 Schedule Tasks
[ Subscription Messages

Select a person who is to perform a review according to the principle of dual control. The possible

-
Summary 52 [ Details| % Impact Analysis| == Viewer| % JT Preview

select-signoff-team

Narne: Type:
select-signoff-team  Select Signoff Team Task

& select Signoff Team
e

E‘ff Signnff Team
=T Profiles
=" ELFFG/Design-Admin/1

S Users
BL Address Lists

<

B8 2 Doe lohn (jdoe) - EI.LFFG/Design-Admin [l

Required || Profiles - Doe, John (jdoe) - EL.FFG/Design-Admin

8

Organization  Project Teams

= Organization
E-f5 FFG
=8
-5 Design-Admin
&_ Bamner, Harti (hbarner)
& Bartkowiak, Jan (jbartkowiak)
IIsY -8 Bauer, Karin (kbauer)

Process Description:

> & Buehler, Christoph (chuehler)
&
oy Dee el (mdeess)

\

~-e& ECKErt. Anna laeckert)
<
Resource Pool Options

Review Quorum

(® Numeric |1 () Percent

Comments

[[] Wait For Undecided Reviewers

v ¥ Ad-hoc done

(®) Any Member (O All Members

%o

® Specific Group Any Group

& Enter User ID or User Name
Enter Role Mame

B
By |Enter Group Mame

[ Required

Remove Modify

T

persons are predefined, i.e. they must have the role ,Design-Admin“ and be in your group (KV).

This concludes your task as a designer with the role ,Design®“.

8.5.4 Review and Release

When you receive a share request, select the appropriate task in your worklist and press the

~Perform” button. The dialog for sharing opens.
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Actions  Window Help

sogae@Ry ®-aa

( Doe, John ( jdoe ) - ELFI

% [3 Home| 8 Home|

A My Worklist

5 |5 Tasks To Track
> [ Schedule Tasks

dusmamonan

v =0 |w Summary 3 Detai\s &, Impact Analysis | o Viewer 5 IT Preview
~ perform-signoffs
Mame: Type:
i perform-signoffs  Perform Signoff Task

Perform Sig X
> |5 Subscription Messages W perform Sig
Process: X.1200,0020-01 COLUMM | STAENDER State: ﬁ Started
Process Description: A
| \ L]
Review Task: Review
ull
Quorum: 1 Wait For Undecided Reviewers: false
ar Responsible Party: Doe, John (jdoe]
e For Review: Attachments All Comments
e Instructions: |5|gnoff team perform their si ffs, c
N
User-Group/Role Required \Decision Comments Date
Doe. John doe)-ELFFG/Desian-Admin Mo
|
& Signoff Decision x
L4
Decision / Comments:
() Reject
(O No Decision
e
I-u‘ T
HPa [ " u
Press the ,,No Decision” link, then the ,Approve” button, then the ,,OK” button.
e o g g@Emmsasaaa
& Home 32 | Ab Home | & My Worklist ) Summary £ [ Details . Impact Analysis| o Viewer| % JT Preview
QB i - “ | SendTo..
5 |5 Create part in Teamcenter ~
% [ Release Processes a X.1200.0020-01 COLUMN | STAENDER
I} > [ X.0000.0003 PIN | BOLZEN
» T X.0000.0004 HOLDING BLOCK | HALTEKLOTZ Ovamaw} Document Propertlas| Classification | Title B\ock‘ EPLAN Properties | Related Datasets | Available Revlsmns‘ Audit Logs‘
5 T X.0000.0007 INDEX TABLE A-AXIS English: COLUMN Add. name English:
» T X.1200.0001 TROUGH | ABFLUSSRINNE German: STAENDER Add. name German:
> M X.1200.0012 COLUMN | STAENDER Cust. lang. Add. name cust. lang.:
» T X.1200.0015 MACHINE COLUMN | MASCHINENSTAENDER . ‘
5 M X.1200.0014 COLUMN | STAENDER Catib: 2937 Add. name (gen.J:
. ¢ ECN-D0007 Deme-Change Dimension: Material:
> [ X.1200.0018 PIN | BOLZEN Standard:
~ 1 X.1200.0020 COLUMN | STAENDER
“"{; X.1200.0020-View Procur.nd.: X Char. Key: E Q-Code: S
> g X.1200.0020-00 COLUMN | STAENDER SE Sched. strategy: R+ W Part: Weight:
> @ X.1200.0020-01 COLUMN | STAENDER SE
3 ﬁ Based On Relation Bom Usage: Standard Part: No Reworlk: Falce
v A ECN-000008 Demo-Change Unit Of Measure (Empty = each): Factor Uol:
v 3 ECN-DDD00E-A Demo-Change Unit Of Issue (Empty = each): Facter UoM:
v [ Problems
> g X.1200.0020-00 COLUMM | STAENDER SE Manufacturer [D: Notes GER:
> 53 Impacted
“ B Solutions ) Manufacturer Name: MNotes ENG:
<N 200.0020-01 COLUMMN | STAENDER 5E Mandatory Manufacturer: False Int.Info:
g View Distributor Order Mr.: Import from:
>
> g X1200.0020-01 5E Eng.Area: After Sales Part: False
» 1% X.1200.0020-01-dwg1 SE
+ 7 K1200.0020-01 w1 SE Design Resp.: GE&L Product Line:
3 & %.1200.0020-01 SE Evaluation class: G&L Shared Part (Sheffield): False
b3 D[EXJZOQODZOJ’M -View SE Replaced By:
SE SE XLO Part ID:
[ SAP Transferform XLO Draw. Now
> 53 Change References
> 5 Plans
» [ Implements Last Release Status: ~ SE SE A Owner: Doe, John Project (EAC-ID): 00002
5 [ AutoCAD Approved By: jdoe Last modified by: deproxy Project (EAC owner):  MAG i
> I View and modify data Approval Date: 04.10.2019 Creation Date: 04-0ct-2019 02:57 Checked-Out:
> [ Office Documents Tange Nor ECN-0DD008 Date Modified: 04-0ct-2013 09:14 Checked Out By:
» [ Standard Parts
> [ Testbaugruppen w £ & dy £
< - > Check Out..  Check In..  Save and Keep Checked-Out  Cancel Checkout...
CP e os

When the workflow has run through, the revision and all objects referenced under it are released and
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the neutral formats have been created. Note that this revision has now received a ,,change number®”.

8.6 SAP transfer ("Growing bill of materials")

8.6.1 Introduction

Even during the development process, bills of material can be transferred to SAP without actually
being released. In this case, parts and bills of material are not write-protected and can be processed
further.

The following rules apply when transferring to SAP:

e The BOM, that is, the revision that represents the assembly, must not have the status , SE“.

e Components or sub-assemblies that have not already been transferred to SAP (i.e. are ,,in
working“ or have the status ,ER") are filtered out during transfer.

e After the transfer, the revision receives the status ,,PS*“, but is not write-protected. The status
,PS" indicates that the BOM or part has been transferred to SAP.

e If a revision already had the status ,ER", it can be transferred to SAP, but it remains write-
protected, that is, the status ,,ER“ is not reset.

8.6.2 Starting the SAP update

Select one (or more) revision(s) to be transferred to SAP. You can do this in the Teamcenter Navigator
or in the Structure Manager.

Press , Ctrl+P“.

Structure Manager &%

X.1200.0020-02 COLUMMN | STAEMDER (View) - Latest Working - Date - "Now"

BIbALy ‘ Rule configured by Item Rev Status Find No. Quantity | Unit Of Measure | Has Children | Reference Designa...| Pa
f/9£.X,1200.0020-02 COLUMN | STAENDER (View] True
“-ggf X.1200.0021-00 MACHINE COLUMM | MASCH... Has Status({ Any Release Status, Configured Using Released Date ),... SE 10 each False

& Mew Process Dialog X

b

Process Name: |,1200.0020-02 COLUMN | STAENDER b %

Cirl=P/ Strg=P

M Description:

Process Template: [FFG 10 SAP BOM Update i

Process Template Filter: @) All (O Assigned
# Attachments ‘g Pm:es&pate Assign All Tasks

Task Attachments
-1 Targets
+-ggf X.1200.0020-02 COLUMN | STAENDER
=~ References

I
Cancel

In the following dialog select the workflow ,,FFG 10 SAP BOM Update” and press ,,OK". There is no
further query, the workflow starts immediately.
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After the workflow has run through, you will see the status ,Preseries” or ,,PS“ at the revision and at
all objects below it. In addition, a so-called ,,snapshot” with the name ,SAP Update” is created, which
contains the parts contained in the structure at the time of the call, so that the respective changes

can be traced.

~ T 12000020 COLUMMN | STAEMDER
= %.1200.0020-View
& ¥.1200.0020-00 COLUMN | STAENDER SE
& .1200.0020-01 COLUMN | STAENDER SE
v @ X.1200.0020-02 COLUMM | STAENDER
g View
7 X.1200.0020-02
%7 ¥.1200.0020-02-dwgT
w o S5AP Update
& %.1200.0021-00 MACHINE COLUMMN | MASCHINENSTAEMDER SE
& %.1200.0020-02 COLUMMN | STAENDER
PsS
[ SAP Transferform
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